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1 Informazioni generali 

Inserendo il codice identificativo per Genebank CDO15728.1 nel motore di ricerca del NCBI, e restringendo il 
campo di ricerca alle sole proteine, posso ricavare delle informazioni di carattere generale sulla sequenza 
amminoacidica in esame. (alcune di queste, e altre informazioni sono disponibili anche su UniProtKB - 
A0A235R8F6 (A0A235R8F6_KLEPN)). 
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1.1 La proteina 

La proteina si compone di 288 residui amminoacidici, ed è codificata dalla sequenza che si estende dalla base 
4201622 alla base 4202488 del DNA cromosomico di Klebsiella pneumoniae, ceppo Kp52.145 (GenBank: 
FO834906.1). 

PdxK è un’abbreviazione per “pyridoxal kinase”, inglese per piridossale chinasi. 
La piridossale chinasi, o ATP:piridossal 5'-fosfotransferasi (EC 2.7.1.35) è un tipo di fosfotransferasi che 
catalizza il trasferimento di un gruppo fosfato da una molecola di ATP ad una molecola di piridossale (vitamina 
B6) per formare piridossal 5’-fosfato e ADP o viceversa, il trasferimento di un gruppo fosfato dal piridossale 
5’fosfato all’ ADP per formare ATP e piridossale, secondo la seguente reazione: 

 

 

 

 

Questa reazione, e quindi quest’enzima o suoi analoghi, sono presenti in un pathway metabolico altamente 
conservato (con delle variazioni) sia nel mondo procariotico che in quello eucariotico, quello della vitamina 
B6. 

Piridossale 

ATP ADP 

Piridossal 5’-fosfato 

Da KEGG 
 https://www.genome.jp/dbget-bin/www_bget?rn:R00174 

Da KEGG 
https://www.genome.jp/kegg-bin/show_pathway?ec00750 



1.2 La specie a cui appartiene 

L’organismo a cui appartiene questa proteina è Klebsiella pneumoniae. Il nome del genere è un omaggio al 
batteriologo tedesco Edwin Klebs. 

 

È un batterio Gram-negativo a morfologia bastoncellare, ed il membro più importante e noto del 
genere Klebsiella (Enterobacteriaceae). 

Può provocare polmonite batterica, sebbene sia più comunemente coinvolto in infezioni acquisite in 
ospedale nel tratto urinario e in ferite, con particolare riferimento a individui immunocompromessi1 e 
presenta svariati ceppi dotati di ipervirulenza e antibiotico resistenza2. 
Da questo batterio viene estratta la klebsprotina, una glicoproteina che in diversi studi sperimentali si è 
dimostrata efficace nel favorire la resistenza alle infezioni3. 

1.3 Allineamento di sequenze evolutivamente correlate 
Un allineamento multiplo con sequenze codificanti la stessa proteina in specie batteriche filogeneticamente 
vicine ci mostra l’altissimo grado di conservazione di questa sequenza proteica 

 

                                                           
1 Klebsiella Infections: Background, Pathophysiology, Epidemiology of Klebsiellae, 27 aprile 2018. 
 ( https://emedicine.medscape.com/article/219907-overview ) 
2 Chang-Ro Lee, Jung Hun Lee e Kwang Seung Park, Antimicrobial Resistance of Hypervirulent Klebsiella pneumoniae: Epidemiology, Hypervirulence-
Associated Determinants, and Resistance Mechanisms, in Frontiers in Cellular and Infection Microbiology, vol. 7, 
2017, DOI:10.3389/fcimb.2017.00483. 
3 Nielsen H, Bonde J, Immunostimulation of blood monocyte function by RU 41.740 (Biostim) in patients with chronic bronchitis, in Int. J. 
Immunopharmacol., vol. 8, nº 6, 1986, pp. 589–92, PMID 3539830 

Dominio Prokaryota 

Regno Bacteria 

Phylum Proteobacteria 

Classe Gamma Proteobacteria 

Ordine Enterobacteriales 

Famiglia Enterobacteriaceae 

Genere Klebsiella 

Specie K. pneumoniae 
Foto di Janice Carr / CDC - CDC, Atlanta, USA 

https://emedicine.medscape.com/article/219907-overview
http://dx.doi.org/10.3389%2Ffcimb.2017.00483
https://www.ncbi.nlm.nih.gov/pubmed/3539830?dopt=Abstract


2 Caratteristiche strutturali 

Esistono fondamentalmente tre approcci per inferire la struttura tridimensionale della proteina. 

• Homology modelling: consiste nel modellare la struttura tridimensionale di una proteina basandosi 
sulle coordinate spaziali di una o più altre proteine a struttura nota, che presentino un’identità di 
sequenza sufficiente. 

• Fold recognition: confrontare una sequenza proteica allineandola con tutti i possibili profili di tutti i 
fold conosciuti, ricavando un punteggio che valuti il migliore. 

• Metodi ab initio: simulazioni di ripiegamento in cui si valutano tutte le possibili interazioni di tutti gli 
atomi con il solvente, cercando la minimizzazione dell’energia libera e considerando fattori sterici. 

2.1 Domini conservati 

Tramite la funzionalità “Identify Conserved Domains”, posso accedere a CD-Search, che è l'interfaccia di NCBI 
per la ricerca nel database dei domini conservati (CDD). 
Questo database contiene allineamenti multipli annotati per quanto riguarda i domini noti, e proteine a 
lunghezza intera, che sono disponibili come matrici di punteggio posizione-specifiche (PSSM) per 
l'identificazione di domini conservati in sequenze di proteine tramite RPS-BLAST, una variante di PSI-BLAST. 

 
Le migliori corrispondenze sono date da due allineamenti multipli rappresentanti la famiglia di domini 
conservati propri delle piridossale o piridossamina chinasi (questo ci è indicato dall’ e-value sensibilmente 
più basso rispetto alle altre tre sequenze). 
Questi sono contrassegnati dai codici PRK08176 e COG2240, entrambi appartenenti alla superfamiglia con 
codice cl00192, denominata:” ribokinase_pfkB_like”.  
Secondo Pfam, questa superfamiglia raggruppa chinasi che accettano un'ampia varietà di substrati, inclusi 
carboidrati e piccole molecole aromatiche, tutti fosforilati su un gruppo ossidrile (come infatti è il 
piridossalfosfato). 
Anche se all'interno di questa superfamiglia esiste un alto grado di conservazione strutturale, il loro livello di 
multimerizzazione varia ampiamente (vi appartengono principalmente monomeri, dimeri e trimeri). 



In oltre possiamo notare che, come suggeritoci dalla funzione, la proteina presenta siti di legame per l’ATP e 
il piridossale, nonché zone di interfaccia per la dimerizzazione. 

2.2 Ricerca di omologhi strutturali 

Effettuando una ricerca tramite BLAST sul database della Protein Data Bank, che contiene strutture proteiche 
tridimensionali, trovo proteine dalla sequenza omologa di cui è stata già depositata la struttura, al fine di 
procedere ad una modellazione per omologia. 
Sono state eseguite diverse ricerche variando i seguenti parametri in varie combinazioni, per essere sicuri di 
non escludere nessuna struttura utile: 

• Algoritmo: pBLAST o PSI-BLAST 
• Matrice di punteggio: BLOSUM62 o PAM250 
• Filtro per le regioni a bassa complessità: attivo, inattivo nella fase di elongazione o inattivo. 
• Peso delle indels (existence/extention): da 11/1, 12/1, 13/1 o 6/2 

Da queste ricerche, il risultato più interessante è quello contrassegnato (su PDB) dal codice 2DDM (2DDM_A 
e 2DDM_B), di cui esistono anche le versioni 2DDW e 2DDO (stessa proteina, stesso organismo, stessi autori, 
edite nella stessa pubblicazione), a risoluzione più bassa.  
Questa proteina è una piridossale chinasi proveniente da E. Coli (ceppo k12), che come K. Pneumoniae fa 
parte della famiglia degli Enterobacteriaceae, ed è quindi correlata funzionalmente ed evolutivamente alla 
nostra proteina di partenza. 
Oltre ad avere un’identità del 71% e una query cover del 96%, ha una lunghezza simile (283 residui), e in tutte 
le ricerche risulta avere un e-value significativamente più basso di quello degli altri risultati (compreso tra 2e-

145 e 5e-102, contro risultati compresi tra 5.3 e 1e-24). 

 

Allineando la sequenza in formato FASTA recuperata dalla struttura PDB tramite una funzionalità di Swiss 
PDB Viewer (che ho riscontrato essere diversa da quella scaricabile dalla pagina di 2DDM su PDB) con la mia 
sequenza di partenza su clustalW e T-coffee, trovo un’ottima corrispondenza, soprattutto, le regioni 
corrispondenti ai domini conservati trovati precedentemente sono conservate anche in questa proteina. 

Noto che la proteina è un omodimero, e la corrispondenza con la mia sequenza riguarda solo uno dei due 
monomeri. 



2.3 Homology modelling 

Effettuo la modellazione tramite SWISS-Model, sulla base della struttura trovata e sulla base di altri due 
risultati (in realtà meno significativi perché hanno un evalue di 6e-22, un’identità del 35%, e sono 
piridossamina chinasi, sempre da E.Coli). 

Per tutti i modelli è stata eseguita una valutazione statistica tramite SAVS, che racchiude Verify, errat, 
prove, procheck e whatcheck4. 

I modelli ottenuti, visualizzati tramite jmol, sono:  

 
 
 
 

 

 

 

 

                                                           
4 Verify determina la compatibilità tra struttura 3D e sequenza amminoacidica, tramite l’assegnazione di classi strutturali. 
Errat analizza statisticamente le interazioni deboli e crea un grafico del punteggio di errore assegnato in funzione della posizione in una finestra di 9 
amminoacidi che scorre tutta la sequenza. 
Prove calcola il volume degli atomi approssimandoli a sfere rigide e ne deriva uno z-score. 
Procheck valuta la qualità stereochimica residuo per residuo e globalmente. 
Tutti questi parametri sono derivati dal confronto con strutture note ad alta risoluzione, che è effettuato indipendentemente tra tutti i vari casi. 



 

 

 

 

2.4 Modello del singolo monomero 
Voglio ottenere anche un modello che rappresenti un solo monomero della proteina omodimerica (come 
per la sequenza di partenza). 

Modifico il file PDB di 2DDM (lo converto in .txt e copio e incollo in un nuovo file solo le coordinate contrassegnate 
come chain A, lo salvo e lo riconverto in .pdb), in modo che contenga solo le coordinate di uno dei due monomeri, per 
usarlo come stampo (wind →layer info) e carico la sequenza di partenza per allinearla e modellarla.  

Allineo le sequenze e valuto l’allineamento (fit→ fit raw sequence e wind → alignment), che ha un’ottima 
corrispondenza del 72.7%.  

Costruisco un modello preliminare (SwissModel → Build preliminary model), ma visualizzando il grafico di 
Ramachandran trovo ancora dei residui in zone non permesse. 

Con Select → Residue making clashes e Tools → Fix Selected Sidechains → Quick and Dirty do una prima sistemata agli 
atomi che si trovano troppo vicini tra loro. 

Con File → Save project (all layers), salvo un file PDB con le coordinate di modello e stampo, utilizzo DeepView per 
raffinare il modello e averne una prima valutazione. 
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2.5 Altri metodi 

Avendo a disposizioni pochi template veramente validi per la modellazione per omologia, ho effettuato dei 
tentativi di fold recognition attraverso phyre2, ma la validazione statistica del migliore dei modelli ottenuti, 
resta comunque più deludente di quella del peggiore dei modelli ottenuti tramite modellazione per 
omologia. 

  

 

 



3 Confronto tra modelli e stampi 

Per un ulteriore valutazione del modello migliore (model_01), procedo al confronto con il suo stampo 
(2DDM_A) tramite SpdbViewer. Questo è stato effettuato sovrapponendo le strutture tramite la funzione 
“iterative magic fit” selezionando soltanto i carboni α.  
 
model_01 e 2DDM: 
L’ RMSD è 0.15Å e secondo il grafico di Ramachandran ci sono pochi residui in zone stericamente non 
permesse. La struttura risulta anche energeticamente favorita tranne che per pochi residui (color → 
threating energy) 

 
 

Modello del monomero e catena A di 2DDM: 
L’ RMSD è 0.19Å e secondo il grafico di Ramachandran ci sono ancora meno residui in zone stericamente 
non permesse. La struttura risulta anche energeticamente favorita per ancora meno residui (color → 
threating energy) [il motivo per cui ci sono meno residui problematici potrebbe essere la presenza di circa della metà dei residui complessivi. 
Una valutazione per confronto diretto non ha senso] 

 



La proteina risulta essere il monomomero di un omodimero, composto da 8 α-eliche, 11 foglietti-β e anse 
che li collegano. Queste ultime sono le regioni più variabili (color→RMS), e per tanto modellate con meno 
accuratezza. Inoltre, è possibile notare diverse strutture supersecondarie, come un grande β-meander 
(Successioni di fogliettiβ antiparalleli) con una curvatura complessiva levogira, intervallato da strutture del 
tipo α-loop-α e β-α-β. 

La presenza della zona di interfaccia per la dimerizzazione e dei siti di legame dell’ATP e del piridossal-
fosfato ci sono confermati da 3DLigandSite (di Imperial college of London Structural Bioinformatics Group). 

Questo strumento ci suggerisce anche la presenza di diversi ligandi metallici come magnesio e zinco, in 
effetti nel monomero esiste una struttura supersecondaria che ricorda un motivo zink-finger, ma il ruolo 
fisiologico della proteina non implica necessariamente siti di legame al DNA, ance se questi potrebbero 
avere fini regolatori. 
Queste osservazioni potrebbero suggerire anche un ruolo pleiotropico dell’enzima nella regolazione 
dell’espressione di geni omologhi o eterologhi, cosa già osservata in vari enzimi metabolici. 
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